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Introduction  
The MSP-REX program is designed to consolidate Microsoft Project Server information 
from multiple projects into a single master Project Pro project or Excel report.   It 
provides a user interface that allows the user to create highly flexible filtration criteria, as 
well as selecting the fields to be displayed in the target file.  For Project files, this is done 
by selecting the Project information from Project Server based on the users filter criteria, 
generating the information into one or more text files in a format called ñXMLò, and using 
Project Pro to convert the files into its native .mpp format.   For Excel, Project 
information is generated into an Excel spreadsheet while you watch. 
 
Report extraction is based on three component parts; Tables, Filters, and Reports.  
Tables are analogous to Tables in Project Pro; they simply identify which fields you wish 
to see on your output.  Likewise, Filters are analogous to Project Filters in the respect 
they allow you to select which Projects and Tasks you wish to see on your output.  You 
can work with Tables and Filters directly in an ad hoc way to create your target Project 
or Excel file, or you can save the specific table and filter information, along with the 
target file and type definitions in a Report.   Report content can also be defined by 
combining multiple filters. 
 
Table, Filter, and Report information can be saved for subsequent reuse.  This 
information can also be organized into sets, for functional organization or for ease of 
sharing. 
 
MSP-REX runs as a program installed on a userôs PC.  Each user maintains their own 
Table, Filter, and Report information, but other configuration settings should be common 
to all users.  MSP-REX provides an administrative interface for configuring those 
settings.  The administrative user(s) for MSP-REX are based upon who has Project 
Server administrative rights. 
 
Information supporting the report extract functionality is primarily based upon the Project 
Server Reporting database.  A limited amount of information is also acquired from the 
Project Server Publishing database.  Users of MSP-REX must be granted read access 
to these databases by an enterprise database administrator prior to usage.  
 
MSP-REX can be configured to access multiple Project Server PWA instances. 
 
This manual is organized in two main sections; a reference section that describes each 
screen in detail, and a walkthrough that describes creating a report extract from scratch. 
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MSP-REX Administration and Setup  
 

Pre-Install 

 
Before MSP-REX can be used by the general user, there are some configuration and 
housekeeping tasks that need to be completed.  Most of them are handled via the MSP-
REX administration dialogs, but there are three items that must be configured outside 
the control of MSP-REX. 
 

 Assignment of the administrator.  MSP-REX determines who has administrative 
rights for MSP-REX configuration based upon who has administrative rights for 
Project Server; specifically the right to create and modify Enterprise Custom 
Fields.  The ñAdministrationò button in the Backstage area will only be available 
to a user who possesses those rights.  The first time a user starts MSP-REX on a 
machine, it will attempt to access Project Server Enterprise Field functionality to 
see if the user has those rights.  This may cause a bit of a start up lag, but MSP-
REX will remember the results so subsequent startups should be faster. 
 

 Assignment of rights to log into the SQL Server that contains the Project Server 
databases of interest (primarily the Reporting DB, but for some functionality the 
Published DB is also needed).  Read only access rights will be needed for those 
databases.  We suggest the use of an Active Directory group, with MSP-REX 
users listed as members.  The administrator does not need elevated rights, read 
only is sufficient.   
 

 If MSP-REX is to be used by multiple users, a network file share directory needs 
to be identified to house the common configuration settings files.  All MSP-REX 
users at a minimum need read access.  MSP-REX administrators need write 
access. 

 
 

Configuration files 

MSP-REX uses a number of different files to manage configuration and definition of 
Reporting sets.  Only one needs to be considered prior to installing the MSP-REX 
executables, MSP-REX-Settings.xml.  This file should be installed in the network file 
share directory noted above.  If there is only a single MSP-REX user the file can be 
installed anywhere.  This is actually just a seed file; weôll be creating PWA specific 
settings files as the administrative process continues. 
 
Other configuration setup tasks are handled via the Administration page.  It is accessible 
via the ñAdministrationò button on the File (Backstage) tab. 
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Initial Setup 

 

License Key Entry 
 

 
 
Until a valid license key is entered, MSP-REX will pop up the license key entry dialog 
after the splash screen is displayed.  You will have a 30 day grace period after the initial 
invocation to review MSP-REX without a license key.  After that period MSP-REX will 
shut down after this dialog is closed unless a valid key is submitted. 
 
To contact Advisicon about purchasing a license for MSP-REX, press the ñRequest 
Purchase Infoò button to start an email message.  Fill in your contact information and 
email it off.   An Advisicon representative will contact you to discuss licensing options, or 
any other MSP-REX questions you might have.  You can also contact us directly, toll 
free, at 866-362-3847.  Typically licenses will be offered at an enterprise level, with 
varying costs depending on number of users.  Frequently Advisicon will have negotiated 
licensing for MSP-REX as part of a larger package, so if you have the product installed 
your company may already have an agreement. 
 
License keys are associated with user login information, so you can install a copy on 
multiple PCôs if you have a login profile on each PC.  You will have to register it for each 
PC, but can reuse the same key for your login.  Different users will have different license 
keys.  Once licensing has been purchased, use the ñRequest Keyò button to request 
your personal license key.   This will trigger an email message prompting you to enter 
contact information.   It will also include your login name which will be used to generate 
the license key.  Upon receipt on the email request Advisicon will validate that your 
company has a license agreement and remaining unused license keys, and if so will 
send you a return email with your personal license key. 
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Once you have the license key you can type it, or more simply just copy and paste the 
key from your email into the text box for the key, and press the ñSubmit Keyò button.  
MSP-REX will validate that the key matches your profile.  If it does the key is saved on 
the PC for future reference and you will not see the Registration dialog again.  If the key 
is rejected and you feel that it is correct for your login please contact Advisicon for 
support. 
 
   
 
 

Configuring the Common Settings Folder 
 
The first time MSP-REX is invoked, a ñBrowse For Folderò dialog will be displayed. 
 

 
 
This dialog is used to define to MSP-REX which common folder the MSP-REX-
Settings.xml was placed in.  Youôll only see this the first time MSP-REX is started up, it 
will remember the location on subsequent uses. 
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You can select the folder by navigating to a drive mapping, or if youôre using a network 
share you can type the UNC name (for example. \\ServerName\SharedFolderName) into 
the Folder box where ñMy Computerò is shown in the illustration. 
 
 
The next step occurs in the background.  MSP-REX checks to see if the user has 
administrative rights by checking against a Project Server PWA instance identified in the 
MSP-REX-Settings.xml file.  This may cause a response time lag; donôt worry if it takes a 
few seconds before the main form displays.  MSP-REX will assume the first person to 
use MSP-REX after the MSP-REX-Settings.xml is installed is an administrator. 
 
At this point you should bring up the Admin dialog via the File Tab/Administration button.   
If you did not preset a PWA URL in the MSP-REX-Settings file, youôll be prompted to 
enter a PWA web address and Database connection info: 
 

 
 
You should then see the Administration page. 
 

Administration Page 

 
Top half of administration page 

 
This portion of the admin page is used to set up configuration information for each of the 
PWA instances that MSP-REX should run against.  It includes the following components, 
which should be defined in the order noted below: 
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1. Common Settings Directory:  This is the directory that you identified in the 
Browser For Folder step, and is shown here for reference. 
 

2. PWA URL:  The URL of the current PWA being configured.  This is the address 
that would be used to access the Project Web Access application, and should be 
consistent with the URL used in setting up Project Proôs Project Server Accounts. 
Entering a URL into this field and navigating to another field will trigger a 
validation step; MSP-REX will attempt to connect to the server to insure it has a 
valid address.   
 
Since the Common Settings File that corresponds to the PWA will have a name 
based on the URL, the Common Settings File box will be updated.  Likewise, the 
Metadata and Field List files (to be described shortly) will also have their names 
derived and the corresponding text boxes filled in.  In addition, the Synch to 
Server (description following) will be automatically invoked. 
 
To create additional PWA references, simply enter the additional URL into the 
URL entry field and tab out. 
 

3. Common Settings File: This is the file that will contain the information entered via 
this section of the admin page.  Each PWA server instance configured will have 
its own copy.  The settings file will have a format of ñMSP-REX-Settings-[PWA 

URL].xmlò, with some character substitution in the URL section to allow for a 

legal file name.  No data entry is needed; the name is generated when a valid 
PWA URL is entered. 
 
This field is presented as a drop down list.  If you are supporting access to 
multiple PWA instances, the list will show and allow you to select the 
configuration settings files that have been created for any of the instances. 
 
 

4. Synch to Server:  This button corresponds to the Metadata File.  Metadata, in this 
context, contains information about Enterprise Custom Fields acquired from 
Project Server to assist MSP-REX generate XML files that Project Pro can read.  
Synch to Server will connect to Project Server, compare its Custom Field 
information against any existing Metadata, and update the Metadata file.  This 
process may need to be repeated on a periodic basis if Enterprise Custom Fields 
are added, changed, or deleted to ensure proper use within MSP-REX. 
 
Once MSP-REX has been configured and is ready for ongoing use, a related 
process can be used to check to see if the Metadata remains in synch with the 
Project Server Enterprise fields.  The first time the Admin button is pressed after 
starting up MSP-REX, or when PWA instances are switched in the Common 
Settings File drop down, MSP-REX will prompt if youôd like to check to see if the 
metadata is current: 
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If you say ñYesò, MSP-REX will compare the metadata file against Project Server 
and identify any fields that have changed, or verify that the Metadata is current.  
The results will be displayed in a dialog box.  If there are differences, i.e. the 
metadata is not current, use the Synch to Server button to resynchronize. 
 

5. Rpt DB Connection:   This is the connection string MSP-REX will use to connect 
to the Reporting database.  You also have the option of entering a connection 
string into the text box directly, or using the Wizard button (item 6).  After entering 
the connection string directly, or generating it via the Wizard, tab out of the 
connection string field to trigger validation.  If the connection is valid, MSP-REX 
will access the Reporting DB and generate a list of fields that are available for 
reporting.  This list can be further filtered down to a more manageable size for 
general usage, see ñUpdate Master Field Listò below for more details. 
 

6. The Wizard button will bring up a Data Link wizard that will help create and verify 
the connection.   
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Data Link Wizard 

 
Enter the name of the SQL Server and Reporting database that the PWA instance 
you are configuring is associated with.  Test Connection will validate your 
connection.  When you click OK, the associated connection string will be placed into 
the Rpt DB Connection text box. 
 
7. Publish DB Connection:   This is the connection string MSP-REX will use to 

connect to the Published database.  You also have the option of entering a 
connection string into the text box directly, or using the Wizard button (item 6).  In 
either case, the connection string will be validated again before the settings are 
saved.  A Published DB connection is not required in this version of MSP-REX, 
unless Predecessor/Successor information is needed on generated Project File 
Gantt charts. 
 

8. The Wizard button will bring up a Data Link wizard that will help create and verify 
the connection, similar to the Reporting DB Wizard. 
 

9. Field List File.  The reporting database contains a large number of fields that can 
be reported upon.  Many of these are not likely to be needed for MSP-REX 
reporting extraction.  MSP-REX allows the administrator to choose a subset of 
these fields to create a master list of fields that the end users can work with.  The 
Field List File contains this master list, as well as additional supporting properties 
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for each field.  This text box contains the name of the master list file for a PWA 
instance, and is generated at the time the PWA URL is validated.  See ñUpdate 
Master Field Listò below for more information about the Field List. 
 
 

Note: Changing PWA URLôs, Synching to Server, and Checking if Metadata is Current 
all make calls to Project Server services.  If the URL is invalid or unset, or even the first 
time a call is made to a valid server, there can be a lag of several seconds before the 
server responds. 
 
 

Update Master Field List 

Between native fields and custom enterprise fields, there are a very large number of 
fields available for reporting.  MSP-REX provides functionality to limit/simplify the 
number of fields the user has to wade through in order to create his table definitions.  In 
addition to selecting the fields that are available for reporting, the Field List helps track 
data type, field aliases for headers, default width to be used for reporting, default 
justification, and default fill down options.  The bottom half of the Admin page, discussed 
below, is used to define these field settings. 
 
Because the potential field list is derived from the Custom Field Metadata and Native 
Fields included in the Reporting DB, the ñSynch to Serverò process and Reporting DB 
connection string must be defined before the initial pick list of fields is available.  
  
 

 
Bottom half of administration page 

 
. 
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The Update Master Fields List section contains the following components: 
 

 
1. The Unselected Columns list:  This list is populated from two sources; the fields 

available in the reporting database, and the enterprise custom fields defined in 
the enterprise custom field metadata file.  It does not include any fields in the 
selected columns list. 
 

2. Find in List:  Because there are so many fields available for reporting, MSP-REX 
provides a quick filter to help you isolate fields of interest.  Simply type all or part 
of a field name and the Unselected Columns list will be reduced in size to only 
include those fields whose names contain the entered letters.  Clear out the 
entered letters with the Backspace key to return to the full sized list.   

 
3. The Selected Column list:  This list includes all fields currently available for 

general MSP-REX usage.  Note that both this and the Unselected Columns list 
are color coded; green for project level fields, yellow for task level fields, and light 
blue for Assignment/Resource level fields.  Fields in both lists will be in 
alphabetical order.  MSP-REX provides a default Selected Columns set when the 
PWA URL, Metadata Synch, and Report DB connection are first defined, but this 
should be altered to fit the needs of you company. 
 

4. Move to selected button:   Moves unselected fields from the Unselected Columns 
list to the Selected Columns list.  Selection can be via single click, or CTRL click 
or Shift click for multiple field selection. 

5. Move to unselected button:   Moves selected fields from the Selected Columns 
list to the Unselected Columns list.  Selection can be via single click, or CTRL 
click or Shift click for multiple field selection. 
 

6. Width.  The default width of a column in Project or Excel.  If nothing has been set 
an initial width of 15 will be used. 
 

7. Width scale bar:  This is a more visual version of the width column.  Moving the 
width pointer should approximate the resulting width on the Project or Excel 
reports.  Note that the width text and the width scale bar are interconnected, i.e. 
changing one will change the other. 
 

8. Alias:  Native field names follow the naming convention they have in the 
Reporting database.  While these are generally understandable, they typically 
concatenate the words in their name and may not make the best labels.  The 
Alias field can be used to replace the database field name to provide a more user 
friendly label.   As for Enterprise Custom Fields, they support embedded spaces 
and normally should not need an Alias, unless a shorter name is needed. 
 

9. Alignment:  Sets the default alignment for the field in the Project or Excel output 
(Left, Right, Center).   Initial defaults are left aligned for text fields, and right 
aligned for other data types (Dates, Numeric, etc). 
 

10. Summary Fill Down:  This option was designed to solve a problem where 
Enterprise Custom Field values were being set at the top task outline level, but 
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were also needed at the subtask level to support calculated fields.  Choosing this 
option causes the value in the top level task to be propagated into its subtasks.  
Note that this does not affect the data in the actual Projects, only the data in the 
generated Project or Excel file. 
 

11. Create Shadow Field:  Project files can contain data at the Project, Task, 
Resource, and Assignment levels.  Normally, when dealing with one project at a 
time Project level information is accessed by bringing up the ñProject Informationò 
dialog box.   When dealing with a single project it is also possible to show the 
Project level values by showing the Project fields in a column, where they show 
the same values for all tasks.   
 
In the case of MSP-REX, we are effectively creating a new ñMasterò project, and 
loading each of the projects selected for generation as a top level task with 
subtasks.  This is analogous to inserting a subproject into a master project 
without clicking on the ñLink to Projectò checkbox, i.e. taking a snapshot of a 
project and inserting it into a master. 
 
The problem with the ñsubproject snapshotò approach is, the master level project 
becomes the owner of the Project level fields, and each subprojectôs Project level 
data is lost.  In order to facilitate reporting Project level data, MSP-REX uses the 
concept of ñShadow Fieldsò.  The way this works is; for each Project level field 
that is of interest for MSP-REX reporting, a Task level version of the Project level 
field should be created.   
 
The ñCreate Shadow Fieldò button aids in this task; when a project level field is 
selected the button becomes visible, and pressing it will create a copy of the 
Project level field at the task level, only using a ñProject: ò prefix on the field 
name.  Note that this field will not contain any data in the physical project; it is 
only used by MSP-REX reporting.   Once a shadow field is created for a Project 
level field, the ñCreate Shadow Fieldò button will no longer be visible.  In the lists, 
although the Shadow fields are defined at a Task level, theyôre shown with a dark 
green background to help them stand out. 
 
When MSP-REX generates the Project file, it will automatically transfer Project 
level data for the ñsubprojectsò to the Task level field with a corresponding 
ñProject:ò prefix.   For example if we had a Project level field named ñLocationò, 
the ñCreate Shadow Fieldò button would create a task level field named ñProject: 
Locationò, and at the time the Project file is being generated the value of the 
ñLocationò field for each project selected would be transferred into the ñProject: 
Locationò field.  The values would be repeated for each task and subtask within 
the subproject, but when the next subproject is displayed its Project level data 
would take effect. 
 
Note that for Excel based output, Shadow Fields are not required; the project 
level data can be rendered directly to Excel.  So if you are only doing Excel 
based reports you will not need to create the Shadow Fields, you can specify the 
Project level fields directly in the table definitions.  The Excel generation will 
honor the use of ñProject: ò fields, so if you wish to generate output in both 
formats you can use the same table definition. 
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Other Setup Tasks 

MSP-REX comes with a preset Default Table with commonly used fields and a preset 
Default Filter (all projects).   If alternate defaults are desired, or some predefined Table, 
Filter, and Report definitions to be commonly used are desired, the administrator should 
create those definitions on his copy of MSP-REX, then Export them to a network location 
where they are accessible to all potential users for import.  Standard MSP-REX 
functionality, as described in the following sections, can be used to perform those tasks. 
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MSP-REX Navigation and Control  
 
MSP-REX uses a navigation and control scheme introduced in MS Office 2007 products 
and continued in their 2010 products; that of having ñribbonsò rather than menu bars and 
a ñBackstageò area for supporting functionality.   The ribbon is divided into three tabs; a 
File (or Backstage) tab, a Select tab, and an Edit tab. 
 

 
The File (Backstage) tab includes the Reports, Export, Admin, 
Options, Help, and Exit buttons.  Each of these buttons, apart 
from the Exit button, will bring up a corresponding work area 
to the right of the button list.  You have already seen the work 
area for Admin, as that section was needed to show how to 
configure MSP-REX prior to general use.  We will defer 
describing the details of the Reports, Export, and Options 
sections until later in this guide as they provide supporting 
functionality that will make more sense after you understand 
the primary functionality.   The Help section provides access 
to this User Guide, as well as ñAboutò information for the MSP-
REX version and Advisicon. 
 

File Tab 

 

 
Select Tab 
 

The Select tab provides the primary area for selecting the PWA to be used, the Projects 
to be included in reporting, Report Sets, running queries, and generating files.  Full 
details will be described in the ñSelect Tabò section. 
 

 
Edit Tab 

 
The Edit tab provides access to the work areas used for editing Tables, Filters, and 
Reports via the corresponding buttons.   Actions provide access to actions common to 
all three areas.  Execution provides quick access to validation and execution for reports 
and filters.  The Current Edit Type shows which type of work area is being displayed.  
The Change Status shows if there are any pending, unsaved changes to Tables, Filters, 
or Reports.    
 
Full details can be found in the Editing Tables, Editing Filters, and Editing Reports 

sections respectively.  All ribbons contain a  in the upper right corner that gives 
quick access to this document. 
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Navigation among the tabs and buttons can also be keyboard driven.  Pressing the ñAltò 
key will highlight a letter on each tab in the ribbon.  After entering the appropriate letter 
for the tab, letters for each of the buttons in the selected ribbon will be highlighted. 
 

 
Alt key navigation and highlighting 

 
For example, if you were in the Select area, to get to the Edit Filters area youôd type Alt, 
then E to get to the Edit ribbon, then F to display the Filter work area. 
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Selection Tab 
 

This is the main form that is displayed upon starting the application.  It includes 
functionality for selecting and applying filters, selecting Projects to be included into the 
generated project or spreadsheet, and generating them to a desired target directory and 
file name.  We will start with a look at the main form, calling out the sections of interest, 
then dive into each section in more detail. 
 

Overview 

 
 

1. This area is used to select PWA Instances, Report Sets, target file to be 
generated, file type to be generated, drive the database queries, and drive the 
file generation process. 
 

2. This area is used to select Reports, Filters, and Tables to be used, and to show 
the details of the currently selected information. 
 

3. This ñselection resultsò area is used to show which Projects satisfy the filter 
criteria after a query against the Reporting database.  It can also be used to 
select projects to be included in the generation list. 
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4. This area is used to control which Projects are moved from the ñselection resultsò 
list into the ñgenerationò list. 
 

5. This ñgeneration listò area is used to show which Projects will be included in the 
generated file. 
 

 

Control Ribbon 

 
Select Tab ï Control Ribbon 
 

The Control Ribbon section contains the following components: 
 

1. PWA Instance Selection.  For those environments where more than one PWA 
instance is available, due to different business groups or having a Development 
or Test instance, MSP-REX can be set to switch between PWA instances.  Each 
instance needs to be configured separately (see MSP-REX Administration).  All 
configured instances will be available via this drop down list, and you can switch 
simply by selecting the instance desired.  Please note that since each PWA 
instance stands alone and may have its own set of Custom Fields, etc, when 
switching to a new instance you may need to also subsequently pick a new 
Report Set. 
 

2. Report Set Selection: Report Sets can be used to share definitions for various 
reports between users, or to standardize on commonly used reports.  This drop 
down allows you to select a current report set.  See Import, Export, and Report 
Sets for more details. 
 

3. This area is used to select the output type (Project or Excel),   
 

4. The target file name is selected by pressing the button with the ellipsis (é), 
which will bring up a file save dialog.  File generation is not possible until a target 
file directory and name are chosen. 
 

5. The Execute Query button will generate the queries against the reporting 
database and return the results to the results list.  If a Filter is active the results 
will be placed in the upper results list, where the user can further pick projects 
heôd like to have generated.  If a Report is active the filter or filters will be 
executed and combined as needed, with the results automatically moved to the 
lower ñselectedò list. 

 

6. Clear Lists:  This button will clear the contents of both the upper and lower 

list.  

 

7.  Generate:  This triggers the process that will generate the Project or Excel file.   
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a. For Project files, MSP-REX performs an intermediate step of generating 
xml files in a format Project Pro can read, and then subsequently imports 
the xml files.  For enterprises with a large number of projects to be 
consolidated into the single project report, the generation process is 
handled in chunks with multiple smaller project files created, then merged 
together in a final step. 

b. For Excel files, MSP-REX opens Excel and dynamically generates the 
content on the fly.  It is important the user allows this process to occur 
without interruption, i.e. donôt start navigating around the report while it is 
still generating. 
 

Report, Filter, and Table Selection 

1. Reports/Filters/Tables tab.  These tabs 
provide access to Report, Filter, and Table 
definitions.  These definitions are further organized 
into groups and are accessible via a tree style 
control to expand or collapse displaying each group 
and its member reports, filters, or tables.  When an 
item is selected with a Report, Filter, or Table tree, 
its details are shown in the Filter/Table detail list. 
 

2. Filter/Table details.  When a report, filter, or 
table item is selected from within a report, filter, or 
table tab, the details are displayed.  Selecting a 
report item will show the file information and type, as 
well as all filters and table information.  Selecting a 
filter will update the filter information, selecting a 
table will update the table information.  It is not 
necessary to select a report first, you can pick and 
combine table and filter combinations and run 
reports in an ad hoc manner based upon that.  
Report definitions are primarily intended for reports 
you wish to run on a regular basis.  Color coding; 
Project level information is light green, shadow fields 
(ñProject: xxxò fields defined at a task level to 
support Project file reporting) are darker green, Task 
level is yellow, and Resource/Assignment level is 
light blue.  For filters you might see an orange line 
that designates Task rendering filters (Filtered Task 
Groups or Filtered Task with Parents), or a pink line 
to show condition groups. 
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Results List 

 
 

1. This is the main results list for execution of a query.  This list shows project level 
fields associated with the active table.  Task level information is not available.  
Items can be further filtered or selected from this list for insertion into the 
ñgenerateò list.   Projects can be selected by clicking on a single project, or 
clicking on multiple projects while using the CTRL or Shift keys.  If multiple 
projects are selected while using the CTRL key, they will be added to the 
selection list individually.  If they are selected while using the Shift key, all the 
items between the current and last item selected are selected, and any items 
outside that range are deselected. 
 

2. Find in List.  This provides a secondary filtering mechanism.  Once a list of 
projects is filtered and displayed in the main results list, you can type into this list 
and the main results list will be further filtered by the contents of Find in List.  
Filtering is only applied to text fields, which will have an asterisk (*) pre-pended to 
their header label.  The entered characters can appear anywhere, i.e. entering 
ñSoftwareò would successfully find ñSoftware Securityò or ñAutomated Softwareò.  
You can enter multiple filters here by separating them with a semicolon.  If 
multiple filters are used a match on any will return the project.  So, entering 
ñEPM;Softwareò would find projects with EPM or Software in any of the fields 
being searched. 
 

 

Move to Generate List 

 
This area is used to select and combine results from the filtered 
results list for insertion into the ñgenerateò projects list.  This area has 
several components: 

a. Selection for ñAllò or ñSelectedò items.   

i.  If ñAllò is selected, all items will have the 
designated action performed upon them, 
regardless of whether they have been selected 
or not. 

ii.  If ñSelectedò is selected, only items that are 
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selected in the filtered results list are affected 
by the designated action.   

b. The + (plus), - (minus), and = (equals) buttons are used to combine 
selected Projects from the results list with any Projects in the selected list.  
Combining criteria can also be done in filter definition, but occasionally 
selection criteria can become too complex and these buttons offer a work 
around. 

c. The + (plus) button will merge selected Projects from the top list (filtered 
results) into the bottom list (generate).  Any projects from the top list that 
are already in the bottom list will be ignored.  This is the most commonly 
used action as it is used to load the initial (or only) selected items from 
the filtered list into the generate list.  It can also be subsequently used to 
add more Projects to the generate list. 

d. The ï (minus) button will compare selected Projects in the top list with 
any Projects in the bottom list, and if they match will remove them from 
the bottom list.  This might be used if you had one filter that gets 
everything you want, but you want to omit a subset of it.  For example you 
might have a filter that gets all projects containing a certain resource, and 
a second filter that gets all projects prior to the current fiscal year.  You 
could combine those two items to only get projects with that resource that 
are current. 

e. The = (minus) button compares selected items from the top list with items 
in the bottom list.  Only items that are in both lists will remain in the 
bottom list. 

f. The trash can is used to remove selected items from the generate list. 
 

 

Generate List 

 

 
 
When you hit the Generate File button, only projects that are in this list will be included in 
the generated Project or Excel file.  

 

Open Project in Project Pro 

This snapshot also includes a ñDouble Click a Project to open in Project Proò note.  
Double clicking on a project from either the Results list or the Generate list will start 
Project Pro and open the selected project.  This functionality will allow you to have a 
closer look at the project if youôre uncertain you want to include it, or even allow you to 
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use MSP-REX primarily as a way to find a particular project or projects for subsequent 
maintenance, independent of report file generation.  Note that if Project Pro is already 
open, but opened local to the PC or using a profile that points to a different Project 
Server instance, the open will fail.  The opened Project Pro instance should be closed 
before retrying.  If Project Pro is already started and pointed to the same Project Server 
instance MSP-REX will simply open the selected project in addition to any other projects 
already open in Project Pro. 
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 Creating and Editing Tables  

 
MSP-REX uses the concept of a ñTableò to define which fields should be shown on the 
generated Project or Excel file.  To Edit a table use the ñEditò tab, then press the 
ñTablesò button (item 1 below) on the Edit ribbon.   
 

 
Table Edit Ribbon 

 
1. Tables button:  This button will bring up the tables work area below the ribbon. 

 
2. Tables Type: This is simply a label and icon to help you identify which work area 

is active in the Edit tab. 
 

3. The title bar should always indicate where you are.  In the case of Table Edit, it 
should also tell you which table is currently being edited. 
 

4. Copy button: Used to create new table definitions. 
 

5. Rename button:  Allows you to rename the table definition.  If the table is being 
used in any report definitions, MSP-REX will automatically rename the table 
assignment in those definitions. 
 

6. Delete button:  Allows you to delete the table definition.  If the table is being used 
in any reports, MSP-REX will warn and prompt you.  You will have the option of 
cancelling the delete, continuing with the delete and ñbreakingò the report 
definition(s), or deleting both the table definition and the report definition(s).  
ñBrokenò report definitions must have a new table assigned to them before they 
can be used. 
 

7. Save button:  Saves the table definition so it is available for future sessions.  
Note that this will also save any pending Filter or Report changes.  

 
8. Reset button:  MSP-REX allows you to make changes to tables without saving 

the changes.  However changes are retained in memory until MSP-REX is 
exited.  The Reset button restores all Table, Filter, or Report definitions to the 
point at which they were last saved.   If you are making a series of changes to a 
table but wish to start over, this will help you get back to where you started. 
 

9. Change Status:  These labels will flag if a change to a Table, Filter, or Report is 
pending.   
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Creating Tables 

Creating a new table definition is always done by copying an existing table.  A Default 
table will always be available for copying, however frequently you may have an existing 
table that is closer to your desired result.  
 
On the Edit Table ribbon, press the Copy button (Ribbon Item 4) or use the Alt key 
sequence.   This will bring up the following dialog: 
 

 
 
 
Initially the ñDefault Columnsò option will be selected and the existing table list will be 
disabled (grayed out).    ñDefault Columnsò is a table definition that will always be 
available.  It can be edited if the preset columns do not match your needs. 
 
The Copy Table option allows you to copy an initial table definition from another table.  
You can subsequently edit the table to add any variations you need.  When Copy Table 
is selected the Table list tree becomes enabled.  You can expand or collapse table 
groupings, and select the table you wish to copy. 
 
To create a new table, enter the table name into the ñSave Table Asò text box and press 
ñSaveò.   If the table definition already exists youôll be prompted to Cancel, or replace the 
existing definition.  If it does not exist the new table is created.   After table creation the 
copied table with the new name will be displayed in the table work area. 
 
 

Editing tables 

Once a table has been created or selected, changes are done simply by moving items 
from the unselected column to the selected column (or vice versa), reordering, or 
entering field properties.  For the property fields (Width, Alias, Alignment, Fill Down) it 
may be necessary to tab out or select another field for the change to be processed.  
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Changes are made a definition in computer memory, you must use the Save button for 
them to persist. 
 

Table Work Area 

The table work area is where selection of and changes to the current table are 
performed.   
 

 
Table Edit Work Area 
 

The Edit Table dialog contains the following components: 
 

1. Table list tree:  This component provides a list of existing table definitions, broken 
out by table groups.  Use the + or ï on the tree to expand or collapse a grouping.  
Normally, when the work area is shown it should already be pointing at the 
current table being used by MSP-REX.   However it is not necessary to select a 
table before going to the table edit dialog; using the list tree you can navigate to 
any table.  Selecting a table within the tree will update the Related Reports list 
(item 5), the selected columns list (item 6), and the Unselected Columns list (item 
7).  Color coding may be used on the tree items; a brown or orange background 
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indicates the table is the current active table in MSP-REX, and a bright yellow 
background implies the table has not been used in any Report definitions. 
 

2. The table name.  It should match the name on the title bar. 
 

3. Group:  Table group to assign the table definition into.  You can either use the 
drop down arrow to select an existing group, or type in a new Group name.  The 
group assignment should be reflected in the table lists, both in item 1 and in the 
lists on the Select form (Table tab) and the Edit Report work area (Table tab).  
Note that Table groups are independent from Report Groups and Filter Groups.  
Naming standards are recommended, but entirely up to the user.   
 

4. Description: Provides a place to show more background information about a 
table than simply naming it would. 

 
5. Related Reports list: When a table is selected in the Table list tree, MSP-REX will 

display any reports that use the table.  This is useful to know, as you then can tell 
what might be impacted if you modify or delete the table. 
 

6. Selected Columns list:  This list displays the columns that have been selected for 
use in the table definition.  Displayed items will show both the internal name and 
the alias, if assigned.  Color coding; Project level information is light green, 
shadow fields (ñProject: xxxò fields defined at a task level to support Project file 
reporting) are darker green, Task level is yellow, and Resource/Assignment level 
is light blue.  Fields are presented in order that they will be shown, from left to 
right, in the generated Project or Excel file.  Fields can be added, removed, and 
re-sequenced by using the buttons noted in items 8-13.  Columns can be 
selected one at a time, or multiple selections done via CTRL Click (individual 
non-contiguous items) or Shift Click (contiguous items in a range).  
 

7. Unselected Columns list:  This list displays the columns that are available to be 
added to the table definition.  It is based upon a master list that is defined by the 
MSP-REX administrator, and can include both built in and enterprise custom 
fields.  Columns from the master list that have already been selected are not 
shown.  Fields are displayed in alphabetical order.  Like the Selected Columns 
list, they are color coded in green, yellow, and blue to reflect Project, Task, or 
Assignment/Resource level fields. Fields are added or removed by using the 
buttons noted in items 8 and 9.  Columns can be selected one at a time and 
manipulated, or multiple selections via CTRL Click. 

 
8. (Single Arrow Right button):  Moves the selected items  in the Unselected 

Columns list to the Selected Columns list.   

 
9. (Single Arrow Left button): Moves the selected items in the Selected Columns list 

to the Unselected Columns list.  Note that any table level customizations for 
Alias, Alignment, etc will be lost ï those properties will revert to the master 
defaults. 
 

10. (Double Arrow Up button): Moves the selected fields to the top of the Selected 
Columns list (left most on the generated Project/Excel file). 
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11. (Single Arrow Up button): Moves the selected fields up (left on output) in the 
column sequence by one column.   Multiple fields can be moved. 
 

12. (Single Arrow Down button): Moves the selected fields down (right on output) in 
the column sequence by one column.   Multiple fields can be moved 
 

13. (Double Arrow Down button): Moves the selected fields to the bottom of the 
Selected Columns list (right most on the generated Project/Excel file). 

 
Note on items 14-18:  These properties are given standard assignments by the 
MSP-REX administrator at the master field list level.  However, they can be 
overridden at the table definition level using these items should you prefer some 
alternatives to the master assignments. 

 
14. Width.  The default width of a column in Project or Excel.  If nothing has been set 

an initial width of 15 will be used. 
 

15. Width Scale Bar:  This is a more visual version of the width column.  Moving the 
width pointer should approximate the resulting width on the Project or Excel 
reports.  Note that the width text and the width scale bar are interconnected, i.e. 
changing one will change the other. 
 

16. Alias:  Native field names follow the naming convention they have in the 
Reporting database.  While these are generally understandable, they typically 
concatenate the words in their name and may not make the best labels.  The 
Alias field can be used to replace the database field name to provide a more user 
friendly label.   As for Enterprise Custom Fields, they support embedded spaces 
and normally should not need an Alias, unless a shorter name is needed. 

 
17. Summary Fill Down:  This option was designed to solve a problem where 

Enterprise Custom Field values were being set at the top task outline level, but 
were also needed at the subtask level to support calculated fields.  Choosing this 
option causes the value in the top level task to be propagated into its subtasks.  
Note that this does not affect the data in the actual Projects, only the data in the 
generated Project or Excel file. 
 

18. Alignment:  Sets the default alignment for the field in the Project or Excel output 
(Left, Right, Center).   Initial defaults are left aligned for text fields, and right 
aligned for other data types (Dates, Numeric, etc). 
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Creating and Editing Filters  

 
MSP-REX uses the concept of a ñFilterò to define which Projects and Tasks should be 
shown on the generated Project or Excel file.   
 
To create or edit a filter, press the Filter button on the Edit tab or use Alt key navigation 
to get to the Edit Filters area. 
 
 

 
Filter Edit Ribbon 

 
1. Filters button:  This button will bring up the filters work area below the ribbon. 

 
2. Filters Type: This is simply a label and icon to help you identify which work area 

is active in the Edit tab. 
 

3. The title bar should always indicate where you are.  In the case of Filter Edit, it 
should also tell you which filter is currently being edited. 
 

4. Copy button: Used to create new filter definitions. 
 

5. Rename button:  Allows you to rename the filter definition.  If the filter is being 
used in any report definitions, MSP-REX will automatically rename the filter 
assignment in those definitions. 
 

6. Delete button:  Allows you to delete the filter definition.  If the filter is being used 
in any reports, MSP-REX will warn and prompt you.  You will have the option of 
cancelling the delete, continuing with the delete and ñbreakingò the report 
definition(s), or deleting both the filter definition and the report definition(s).  A 
report with multiple filters can still function if one of them is deleted, however the 
results will likely be different. A report needs at least one filter, even if the filter 
does not contain any filtering criteria. 

 
7. Save button:  Saves the filter definition so it is available for future sessions.  Note 

that this will also save any pending Table or Report changes.  

 
8. Reset button:  MSP-REX allows you to make changes to filters without saving the 

changes.  However changes are retained in memory until MSP-REX is exited.  
The Reset button restores all Table, Filter, or Report definitions to the point at 
which they were last saved.   If you are making a series of changes to a filter but 
wish to start over, this will help you get back to where you started. 
 

9. Check Conditions:  Before a set of conditions can be used to filter a query, it 
must pass certain validation rules.  Check Conditions will make a validation 
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check, and potentially modify the conditions to satisfy the rules.  If a condition is 
modified a warning dialog will be posted.  This same process is also done when 
attempting to Save a filter, the Check Conditions button just lets you do a 
preemptive check while you are building your filter.  Check Conditions will be 
explored in more detail later in this section. 
 

10. Run Query:  This button is analogous to using the Run Query button on the 
Select form.  It will check conditions (see item 9), and if valid will switch the view 
to the Select form and execute the Filter.  This ñshort cutò is useful for testing a 
filter to see if it returns the expected data.  Note that the filter information is not 
saved; you will need to return to Edit Filter and Save the filter if you want to retain 
the modifications. 
 

11. Change Status:  These labels will flag if a change to a Table, Filter, or Report is 
pending.   

 
 

Creating Filters 

Creating a new filter definition is always done by copying an existing filter.  A Default 
filter (All Projects) will always be available for copying, however you may have an 
existing filter that is closer to your desired result.  
 
On the Edit Filter ribbon, press the Copy button (Ribbon Item 4) or use the Alt key 
sequence.   This will bring up the following dialog: 
 

 
 
Initially the ñAll Projectsò option will be selected and the existing filter list will be disabled 
(grayed out).    ñAll Projectsò is a filter definition that will always be available, and is 
essentially a filter without any filter criteria.  
 
The Copy Filter option allows you to copy an initial filter definition from another filter.  
You can subsequently edit the filter to add any variations you need.  When Copy Filter is 
selected the Filter List tree becomes enabled.  You can expand or collapse filter 
groupings, and select the filter you wish to copy. 
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To create a new filter, enter the filter name into the ñSave Filter Asò text box and press 
ñSaveò.   If the filter definition already exists youôll be prompted to Cancel, or replace the 
existing definition.  If it does not exist the new filter is created.   After filter creation the 
copied filter with the new name will be displayed in the filter work area. 
 

Editing Filters 

After creating a new filter or a filter has been selected, filter details are modified in the 
filter work area. 
 

 
Filter Work Area 

 
 

1. Filter List tree:  This component provides a list of existing filter definitions, broken 
out by filter groups.  Use the + or ï on the tree to expand or collapse a grouping.  
Normally, when the dialog is raised it should already be pointing at the current 
filter being used by MSP-REX.   However it is not necessary to select a filter 
before going to the filter edit dialog; using the list tree you can navigate to any 
filter.  Selecting a filter within the tree will update the Related Reports list (item 2), 
and the filter conditions list (item 9).  Color coding may be used on the tree items; 
a brown background indicates the filter is the current active filter in MSP-REX, 
and a bright yellow background implies the filter has not been used in any Report 
definitions. 
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2. Related Reports list: When a filter is selected in the Filter List tree, MSP-REX will 
display any reports that use the filter.  This is useful to know, as you then can tell 
what might be impacted if you modify or delete the filter. 
 

3. Field Source:  Selecting one of these option buttons will populate the ñFilter 
Fieldsò list with prospective search fields at that level. For example, selecting the 
ñTaskò option will cause the ñFilter Fieldsò list (item 4) to be populated with Task 
level fields from the master field list ï both native and enterprise custom fields.   
 

4. Filter Fields: This list will contain the available fields that can be used for filtering 
at the level identified via the Field Source (item 3) option.  When you click a field 
in this list, it will set up values pick list or data range entry, depending on the data 
type of the selected filter field.  
 

5. Values:  
o For text based fields, clicking on a Filter Field item will result in the existing 

values for that field to be shown in the Values list. To include one or more 
values in the filter criteria, select the values of interest via single mouse click, 
or optionally with Shift or Ctrl as appropriate.   

o For numeric fields, clicking on a Filter Field item will result in two text entry 
boxes being shown to allow selection of the field value within a range.  Range 
selection is inclusive, i.e. if you enter 0 and 100 values equal to 0 or 100 
would be included.   

o For date fields, clicking on a Filter Field item will result in two date entry 
boxes being shown to allow selection of the field value within a date range.  
Each date entry box includes a down arrow which will pop up a calendar that 
can be used to select the date within a calendar context.  The calendar 
includes left and right arrows for scrolling months, or click on the month name 
will pop up a month name list for selection.  Years can be selected by clicking 
on the year value; a year scroll bar will become visible. A date can be picked 
by selecting the day of the month.  Clicking on ñTodayò will set the item to 
Todayôs date (which is the default value).  As in numeric values, date ranges 
are inclusive.   

o If the selected field already has conditions, an attempt is made to match the 
values with the conditions for that field, with any matches given a light gray 
background color.  As the conditions may be refined or altered this matching 
is not always possible. 
 

6. Find: Provides a method of filtering down the list of values found for a specific 
text field.  It works the same way the ñFind in Listò filter on the Main form window 
works; just type in characters and itôll pattern match.   Reducing the size of the 
pick list can help pick specific values to filter upon. 
 

7. Values Outline Level / Generic Resource Only: As the values list can show all the 
distinct values in Project Server for all existing projects, this list has the potential 
to grow very large, especially for Task or Resource Names.  In the interest of 
keeping the list manageable, we provide a means to limit how many values are 
returned: 
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a. If a Task Field Source is selected, you can control how deep into the 
Outline Levels MSP-REX will search for values.  By default you can go 
two levels deep, use the drop down to select a different level. 

b. If a Resource Field Source is selected, along with the ñResourceNameò 
field, a check box is provided that will enable you to toggle between a list 
of all resources and only generic resources. 
 

8. (Down Arrow button):  Once items are selected in the value list or set in range 
entry, use the Down Arrow to move the criteria for the selected field into the 
Conditions list.  If multiple values are selected, the default behavior is to create 
multiple conditions with an ñOrò connector. 

 
9. Filter Conditions List:  When conditions are selected from the ñFilter Field and 

Filter Field Value Selectionò process, they are moved into the Condition List.  As 
you may wish to have alternatives to simply picking exact values to filter on, or 
numeric or date ranges, once a field/condition has been added to this list it can 
be refined by double clicking on the item.  This will bring up a ñRefine Conditionò 
dialog which will be described later in this Filtering section.  In addition, a more 
expanded discussion of filtering considerations will be presented.   
 
Short Cut:  If you know youôre going to use a condition other than Equals for text 
or Between for dates and numbers, or you donôt wish to go hunting for specific 
values, you can Right Click on a field name in the Filter Fields list.  This will 
cause the selected field to be immediately added to the Conditions List, and the 
Refine Condition dialog displayed for that field.  Refine Conditions will be 
described in more detail shortly. 
 

10. Task Rendering: This option allows you to limit what tasks get rendered in the 
generated Project or Excel file.  For task level rendering control the filter must 
have either Task level or Resource level filter fields defined.  Option behavior 
works as follows:  

 
a. All Tasks: All tasks and subtasks for selected projects will be rendered, 

regardless of whether Task/Resource level selection criteria have been 
provided. 

b. Task Hierarchy:  If a task satisfies the task/resource selection criteria, 
only that task and any task parents going up to outline level 1 will be 
rendered. 

c. Filter Group From Top:  If a task satisfies the task/resource selection 
criteria, it and all sibling subtasks going up to outline level 1 will be 
rendered. 

d. Filter Group From Bottom:  This is essentially a combination of items b 
and c; if a task satisfies the task/resource selection criteria, that task and 
any task parents going up to outline level 1 will be rendered, as well as all 
subtasks of the task that satisfies the selection criteria. 

 
Note that for Reports, multiple filters can be applied. If any of the filters include 
Task Hierarchy, Filter From Top, or Filter From Bottom, tasks will be filtered from 
the generated file, even if one of the filters includes ñAll Tasksò.  If more than one 
of the non ñAll Tasksò options is present in the filters, all tasks that satisfy any of 
the filters will be rendered. 
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11.  (Up Arrow button): This can be used to move one or more items in the condition 

list up one line.  This can be useful for rearranging filters. 
 

12. (Down Arrow button): This can be used to move on or more items in the condition 
list down one line.  This can be useful for rearranging filters. 
 

13. (Trash Can button): This can be used to delete one or more items from the 
condition list. 

 
14. Group:  Filter group to assign the filter definition into.  You can either use the 

drop down arrow to select an existing group, or type in a new Group name.  The 
group assignment should be reflected in the filter lists, both in item 2 and in the 
lists on the Main form (Filter tab) and the Report form (Filter tab).  Note that Filter 
groups are independent from Report Groups and Table Groups.  Naming 
standards are recommended, but entirely up to the user. 
 

15. Description: Provides a place to show more background information about a filter 
than simply naming it would. 
 

  
 

Refining Conditions 

 
Non Date version  
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Date version  

 

 

While the generation of conditions from the Filter Field and Filter Field Value mechanism 
will likely satisfy the majority of filtering needs, some additional tweaking is sometimes 
needed.   For example, how does one change the default ñAndò for a group to an ñOrò for 
a group?   What if ñ=ò or ñBetweenò isnôt quite what you want? 
 
Double clicking on an item in the condition list will pop up the ñRefine Conditionsò dialog.  
The dialog will be defaulted to show the current values for the condition.  Using this 
dialog, the user can change ñAndôsò to ñOrôsò, ñOrôsò to ñAndôsò, and add ñAnd/Orò to 
those lines that donôt have them (the first item in a group does not have And/Or).  The 
condition test can also be changed from ñ=ò or ñBetweenò to one of ñ=, >, <, >=, <=, <> 
(not equal), Between, In, Contains, Not Contains, Null, or Not Nullò.   The condition value 
can also be changed. 
 
For those who may not be familiar with Between, Contains, In, or Null; a quick primer: 

 ñBetweenò is used to specify a range of values.   For example with quantity 
Between 50 and 100, all values between 50 and 100, as well as the values 50 
and 100 would be included.   

o When specifying dates, time should also be a consideration for the high 
end of the range.  This is because under the covers, comparisons include 
time, and if no time is specified 12 AM is assumed.  So Finish Date 
Between 9/1/2010 and 9/30/2010 really means between 9/1/2010 at 12 
AM and 9/30/2010 at 12 AM, so anything after 12 AM on 9/30/2010 would 
not be included.  Therefore, we recommend using the following date 
(10/1/2010 in this case) for the high end of a range.  This also holds true if 
youôre doing a < (less than) comparison. 

 ñContainsò is used with text values (i.e. not numbers or dates).  It allows you to 
find items where you only specify part of a value, for example ñContains Softò 
would find any of these values: ñSoftwareò, ñSoft touchò, ñA soft bedò.  

 ñInò is used to find exact values in a list.  For example, if you wanted to look for 
tasks named ñAnalysisò, ñDesignò, or ñTestingò, you could use a single ñInò test 
and just list those values rather than having to create a multiple = tests linked 
together with Orôs. 

 Null is a concept that means we have no value specified.  It is distinct from 
spaces and is often used with dates to show a date has not been called out.  
Since Null doesnôt have a value, it canôt be compared directly to something that 
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has a value as there is no basis for comparison.  However we can check to see if 
something is Null or is Not Null. 

 
If the field being refined is a date field, the calendar control will be shown; otherwise it 
will be hidden.  This control can be used as noted in ñFilter Field Value Selectionò.   If the 
test is ñBetweenò, the first click on a calendar day will yield the start date in the range, 
and the second click will yield the finish date.  Navigation between calendar day clicks is 
still possible. 
 
If ñBetweenò is used for a text field test, the format for the value must be  
 

óxxxxxxxô and óxxxxxxô 
 
with the values within single quotes in order to contain embedded spaces.  Likewise, if 
ñInò or ñNot Inò is used for a text field test, the format for the value must be  
 

óxxxxô, ôxxxxô, ôxxxxxô   
 
If ñNullò or ñNot Nullò is used, there should not be a value in the value text box.  For other 
text value tests, only a single value applies and the quotes are assumed. 
 
Cost values are expected to be numeric, date values are expected to be valid dates. 

 

The Condition List and Condition Groups (And, Or, What?) 

Filter support allows for the creation of complex filtering, i.e. the ability to filter by more 
than one filter criteria.  These criteria are linked together by ñAndò or ñOrò statements.  
ñAndò implies that all of the conditions linked together via the ñAndò statement must be 
true for an item to be included by the filter.  ñOrò implies that any of the conditions linked 
together via the ñOrò statements can be true for an item to be included by the filter.   
 
Combining ñAndò and ñOrò together can sometimes yield unexpected results.  For 
example, if you linked the conditions  
 

       Status = óIn Processô  
Or   Status = óCompleteô  
And Actual Total Cost > 5000  

 
you might think that either status and cost > 5000 would satisfy the filter.  However the 
expression engine gives ñAndò precedence, so the condition would really be  
 

      Status = óIn Processô  
Or (Status = óCompleteô And Actual Total Cost > 5000)  
 

In other words, óIn Processô would satisfy the filter regardless of what the Actual Total 
Cost is.   Because of this potential confusion, filtering allows for Condition Groups.  This 
mechanism is quite similar to filtering condition groups in Project Pro. 
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Like simple criteria, Condition Groups are linked together via ñAndò or ñOrò statements.  
The difference is, Condition Groups allow the user to mix ñAndôsò and ñOrôsò without the 
confusion noted above.  For example:    
 

           Status = óIn Processô    (Condition Group 1) 
    Or   Status = óCompleteô  
And  
           Actual Total Cost > 5000   (Condition Group 2) 

  
In this case the ñOrò conditions are evaluated together so either of the statusôs would 
satisfy the criteria regardless to the Actual Total Cost, and the Total Cost criteria would 
be subsequently applied.  So, unlike the ungrouped condition, óIn Processô would only 
satisfy the filter if Actual Total Cost was also > 5000. 
 
Another way to think about Condition Groups is by envisioning each group to be 
contained within parenthesis, thereby establishing precedence.  So, the condition set 
above could be thought of as 
 

(Status = óIn Processô Or Status = óCompleteô) And (Actual Total Cost > 5000) 
 
How then, are Condition Groups created?  When a condition is generated from the Filter 
Field and Filter Field Value mechanism, the results are automatically generated into a 
new Condition Group, linked with an ñAndò statement.   If the condition was generated 
from a text based field and multiple values were selected from the value list, each value 
is given its own condition line within a Condition Group, linked with an ñOrò statement.  A 
Condition Group can be differentiated from linked items within a group based on the 
ñAndò or ñOrò statement being left adjusted, and on a line by itself to start the grouping.  
The first set of conditions is included in a default Condition Group.  
 
Combining items from different groups within a single group can be done by selecting an 
item and moving it to a different group via the Up or Down arrow to the right of the 
condition list.  Items, including the ñAndò or ñOrò from a condition group can be removed 
by selecting the item via mouse click, then clicking on the trash basket icon.  As a rule of 
thumb, you should not combine ñAndôsò and ñOrôsò within a single group, as that would 
just lead back to the confusion we started off with. 
 

 

Checking Conditions 

The ñCheck Conditionsò button is used to provide a level of validation for the conditions 
and condition groups.  While this functionality is automatically invoked when a filter is 
being saved, or being used without being saved, manually clicking the button while 
creating the condition set is considered a best practice.  In addition to validation, this 
process will automatically correct some errors and set some defaults.   If an adjustment 
is made a message dialog will bring this to the userôs attention so the adjustments can 
be verified.   The Check Condition process does not guarantee the condition set is 
bulletproof, however it will catch most problematic errors.   
 
Check Conditions will perform the following checks: 
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 Group level And/Orôs: 
o If moving member conditions around leaves a group level And/Or 

stranded at the beginning or end of the condition set, it will be removed. 
o If moving member conditions around leaves group level And/Or items 

next to each other, all but the first will be removed. 
 

 Blanks, Andôs, and Orôs configured ï the first list item, and first item of all 
Condition Groups should be blank, and will be set to blank if not.  Any blank 
condition item that is not the first item in a group will be defaulted to ñAndò. 
 

 Mixed Andôs/Orôs within a group ï if ñAndò and ñOrò are both found within the 
same Condition Group, a warning message is posted. 

 

 Combining Project, Task, and Resource conditions within the same group ï the 
default behavior for filtering is designed to apply each filter to a Project as a 
whole.  In other words, when specifying filters at the task level and at the 
resource assignment level each would be applied against the project 
independently.   If a combination of a specific Task and Assignment is desired 
special rules (see next section) will be applied.   This check will see if Project, 
Task, and Resource Assignments are within the same group, and if so move the 
Project filter conditions into a separate group, and trigger the special rules for 
Task/Resource combinations.  

 
Failing the ñCheck Conditionò process will prevent the Save, or Execute Filter processing 
from occurring.  Passing the process will automatically update the ñin memoryò version of 
the filter, making it available for use. 
 

Special Task/Assignment Conditions 
When a Task level test and a Resource Assignment level test are combined within the 
same Condition Group, special considerations apply. 
 
Best practices for Project Resource Assignments state that the Assignment should occur 
at a subtask level, rather than a summary task level.  As a task filter may be expressed 
in terms of finding a summary level task, but resource requirements really apply to the 
subtasks, there may be a disconnect between how the Task/Resource filter is requested 
and how the relationships actually exist.   For example, a user might want to include only 
Projects that have a Construction task with Electricians assigned to more than 20 hours 
of work.   For example, you might have a ñConstructionò summary task, and a ñWire 
Breaker Boxò subtask, with the Electrician resource assigned to the ñWire Breaker Boxò 
task.   If the search is on ñConstructionò and ñElectrician hours > 20ò, we somehow have 
to make the connection between assignments made on ñWire Breaker Boxò and the task 
named ñConstructionò.  If the Task and Resource criteria are contained within the same 
condition group, MSP-REX will assume the task may be a parent task.   
 
If there is an interest in doing filters that include both Task level and Assignment level 
criteria, but the Assignment level criteria could be applied to resource assignments for 
any task, place the Assignment test in its own Condition Group. 
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Creating and Editing Reports  
MSP-REX uses the concept of a ñReportò to define a combination of Filters and Tables, 
along with the desired report type (Project or Excel) and the desired target location and 
file name.  While it is possible to generate a report ñad hocò, simply by creating or using 
existing tables and filters and handling the definitions and execution of each report piece 
manually, saving the component pieces in a Report definition makes it easier to run the 
report on a regular basis, and provides a starting point for creating new, related reports. 
 
To create or edit a report, press the Report button on the Edit tab or use Alt key 
navigation to get to the Edit Reports area. 
 
 

 
Report Edit Ribbon 

 
1. Reports button:  This button will bring up the report work area below the ribbon. 

 
2. Report Type: This is simply a label and icon to help you identify which work area 

is active in the Edit tab. 
 

3. The title bar should always indicate where you are.  In the case of Report Edit, it 
should also tell you which report is currently being edited. 
 

4. Copy button: Used to create new report definitions. 
 

5. Rename button:  Allows you to rename the report definition.   
 

6. Delete button:  Allows you to delete the report definition.  Any member tables or 
filters are not deleted, they remain available for future assignments. 
 

7. Save button:  Saves the report definition so it is available for future sessions.  
Note that this will also save any pending Table or Report changes.  Before 
saving it will verify at least one filter and only one table is present (with the table 
as the last item).  If those conditions are not met it will not Save. 
 
Note that despite the validation check, it is still possible for a report definition to 
be ñbrokenò.  This could happen if a member filter or table is deleted, and the 
user opts to ñbreakò the report rather than cancelling or deleting both the filter or 
table and the report.  Also, if a report is initially created using the default ñRpt ï 
No Contentò option it will be ñbrokenò until filter and table assignments are made.  
If a report is ñbrokenò it should be shown with a red background both in the tree 
list in item 1 below and the Report Tree list on the Report tab on the Select form. 

 
8. Reset button:  MSP-REX allows you to make changes to filters without saving the 

changes.  However changes are retained in memory until MSP-REX is exited.  
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The Reset button restores all Table, Filter, or Report definitions to the point at 
which they were last saved.   If you are making a series of changes to a filter but 
wish to start over, this will help you get back to where you started. 
 

9. Check Conditions:  Before a set of conditions can be used to filter a query, it 
must pass certain validation rules.  Check Conditions will make a validation 
check, and potentially modify the conditions to satisfy the rules.  If a condition is 
modified a warning dialog will be posted.  This same process is also done when 
attempting to Save a filter, the Check Conditions button just lets you do a 
preemptive check while you are building your filter.  Check Conditions will be 
explored in more detail later in this section. 
 

10. Run Query:  This button is analogous to using the Run Query button on the 
Select form.  It will verify at least one filter and only one table is present (with the 
table as the last item), and if valid will close the Edit Report dialog and execute 
the report from the Main window.  This ñshort cutò is useful for testing a report to 
see if it returns the expected Projects.  Execute Report does not trigger the 
Generation process; it only sets the current table, any target file and output type 
information, and executes the member filters and Actions.  If you continue 
without saving you will need to return to Edit Report later and Save the report if 
you want to retain the modifications. 
 

11. Change Status:  These labels will flag if a change to a Table, Filter, or Report is 
pending.   

 

Creating Reports 

Creating a new report definition is always done by copying an existing report.  A Default 
report (No Content ï not executable) will always be available for copying, however you 
may have an existing report that is closer to your desired result.  
 
On the Edit Report ribbon, press the Copy button (Ribbon Item 4) or use the Alt key 
sequence.   This will bring up the following dialog: 
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Initially the ñRpt ï No Contentò option will be selected and the existing report list will be 
disabled (grayed out).    ñRpt ï No Contentò is a report definition that will always be 
available, and is essentially a report without any filters or tables assigned.  
The Copy Report option allows you to copy an initial report definition from another 
report.  You can subsequently edit the report to add any variations you need.  When 
Copy Report is selected the Report List tree becomes enabled.  You can expand or 
collapse report groupings, and select the report you wish to copy. 
 
To create a new report, enter the report name into the ñSave Report Asò text box and 
press ñSaveò.   If the report definition already exists youôll be prompted to Cancel, or 
replace the existing definition.  If it does not exist the new report is created.   After report 
creation you will be transferred to the Report Edit dialog. 
 

Editing Reports 

After creating a new report or a report has been selected, report details are modified in 
the report work area. 

 
Report Work Area 

 
A report definition must include at least one filter and one table definition to be useable.  
Any number of filters can be used/combined.  Only one table can be assigned, and must 
be the last item assigned.  When filters are assigned, you also need to include the 
action, corresponding to the +, -, = button on the Select form.   
 
The Report Edit dialog contains the following components: 
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1. Report List tree:  This component provides a list of existing report definitions, 

broken out by report groups.  Use the + or ï on the tree to expand or collapse a 
grouping.  Normally, when the dialog is raised it should already be pointing at the 
current report being used by MSP-REX.   However it is not necessary to select a 
report before going to the filter edit dialog; using the list tree you can navigate to 
any report.  Selecting a report within the tree will update the Contributing 
Filters/Tables list (item 5).  Color coding may be used on the tree items; a brown 
background indicates the report is the current active report in MSP-REX, and a 
red background implies the report is ñbrokenò, i.e. it is missing a filter or report 
assignment. 
 

2. Filter/Table tab and Tree Lists:  Clicking on the Filters or Tables tab will display a 
tree list of existing filters and tables, respectively.  The Tree lists group by Filter 
Groups or Table Groups as appropriate.  Expand/Collapse groups as in other 
trees.  Selecting a filter or table within a group makes it available to be assigned 
to the report being edited. 
 

3. Action drop down:  When a report is executed, each filter is executed and the 
results are applied to the Generate list on the Select form, using an action that 
corresponds to the + (plus), - (minus), or = (equals) buttons that form.  The drop 
down actions correspond to the buttons as follows: 
 

a. Merge ï corresponds to + (plus) 
b. Subtract ï corresponds to ï (minus) 
c. Only Matches ï corresponds to = (equals) 

 
See the + (plus), - (minus), or = (equals) button descriptions in the Select form for 
a description of their behavior. 
 
 An Action is required for filters.  If the Tables tab is active the Action drop down 
is disabled, by default table action is always ñApply Tableò. 

 
4. (Right Arrow button):   Once a filter or table has been selected, it can be 

assigned to the report.  Use this button to make the assignment.  Note that while 
a report can only support one table, this button will allow any number of tables.  
The reason this is allowed is it helps change a table assigned; you can add a 
new table before or after deleting the old table.  However, it will check to verify 
the filter or table being assigned isnôt already in the Filter/Table list; if it does a 
warning is posted and the assignment is not made. 
 

5. Contributing Filter/Table list: This list shows any filters or tables that are assigned 
to the report being edited.  Once a report or filter has been assigned to the 
report, it can be moved up or down, or deleted using button items 6-8.  The 
assigned table must be the last item.  The order of filters can be significant, 
depending on the Actions assigned.  Filters are executed in the order presented. 
 

6. (Up Arrow button):  Used to move filters up in the execution sequence. 
 

7. (Down Arrow button): Used to move filters down in the execution sequence, or to 
move the table item to the bottom. 
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8. (Trash Basket button): Useful for replacing filter or table assignments.  Add the 

new assignment via the right arrow button (item 5) and delete the old assignment 
via this button.  Can also be useful to remove items assigned in error. 
 

9. Filter/Table Details: This list shows the details of the filters and tables that have 
been assigned to the report definition. Information is shown in the same 
sequence as the filter list (item 5), and has the same sequence validation 
requirements.  Color coding; Project level information is light green, shadow 
fields (ñProject: xxxò fields defined at a task level to support Project file reporting) 
are darker green, Task level is yellow, and Resource/Assignment level is light 
blue.  For filters you might see an orange line that designates Task rendering 
filters (Filtered Task Groups or Filtered Task with Parents), or a pink line to show 
condition groups.  Note that while tables can be defined with Project level fields 
(light green), they are only supported for Excel output.  For Project output they 
will be ignored if present; you should use shadow fields to reflect Project level 
data in Project generation.  MSP-REX will warn you if your report definition is for 
Project output and includes Project level fields. 
 

10. Group:  Report group to assign the report definition.  You can either use the drop 
down arrow to select an existing group, or type in a new Group name.  The group 
assignment should be reflected in the report lists, both in item 1, and in the list on 
the Select form (Report tab).  Note that Report groups are independent from 
Filter Groups and Table Groups.  Naming standards are recommended, but 
entirely up to the user. 
 

11. Description: Provides a place to show more background information about a 
report than simply naming it would. 
 

12. (é button ï ellipsis): The target file directory and name is selected by pressing 
this button, which will bring up a file save dialog.  This file will be reflected on the 
Main form when the report is selected.  A target file is not required to save the 
report definition, but if it is not assigned it must be assigned at the time the report 
is generated. 
 

13. Output Type: This option designates what type of report is desired (Project or 
Excel).  This will be reflected on the Main form when the report is selected. 
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 Report Sets 

Overview 

The discussion thus far has been limited to the context of a single userôs reporting 
needs.  This is in part because by default, all the Report, Table, and Filter definitions are 
stored in files in the user profile area of a userôs PC.  But what happens if you create a 
really cool report and want to share it with fellow MSP-REX users, or you create a whole 
series of cool reports you like to share?  Or maybe youôre the administrator and would 
like to publish a standard set of reports that anyone can use? 
 
MSP-REX provides the concept of ñReport Setsò, along with Import and Export 
functionality to deal with these issues.  A Report Set is really nothing more than the file 
that your Report, Table, and Filter definitions are stored in.  In order to share the reports 
that you or someone else has defined, these definition files can be Exported and 
Imported. 
 
A Report Set is stand alone.  In other words only one Report Set can be active at a time 
within MSP-REX, and all the functionality described up to this point is done within the 
context of that Report Set.  The current report set is named and can be selected in the 
Context Bar in the ribbon of the Select form 
 

.   
 
When you start up MSP-REX, it will remember the last Report Set you used, as well as 
the last Report, Filter, and Table, and start you up where you left off. 
 
Changing Report Sets is a simple as clicking on the drop down arrow and selecting a 
new report set.  It should be noted that the Filters, Tables, and Reports within a Report 
Set are associated with a specific PWA instance, as it may reflect custom fields that are 
specific to a PWA.  As such, if you have an environment where multiple PWAôs are 
supported, you should use a naming convention on your Report Sets to help avoid 
confusion.  MSP-REX will allow you to use a Report Set based on one PWA against a 
different one, but unless the field names referenced are common to both you may get 
errors.   When switching PWA instances (via the drop down just above the Report Set 
drop down), MSP-REX will warn you about the need to switch Report Sets. 
 
 

Export 

Before we can deal with someone elseôs Report Set, or they can deal with yours, it first 
needs to be Exported.  Export functionality is available via the File (Backstage) tab, and 
the Export button. 
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Backstage Export Page 

 
1. Navigate to the Export page via the File tab 

 
2. and the Export button. 

 
3. This text block describes the Export process. 

 
4. Exporting occurs within the current context: 

a. PWA Instance 
b. Report Set 
c. Report (for single report Export) 
d. Filter (for single report Export).  If the report being exported includes 

multiple filters, all will be included. 
e. Table (for single report Export) 

 
5. Exporting can occur at two levels, the full current Report Set, including all Report, 

Filter, and Table definitions, and a single Report.  Single report Export files 
include only the Report, Filter, and Table definitions specific to that report.  
Currently exporting is only done to a format called ñXMLò, which can in turn be 
Imported into another userôs MSP-REX. 
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After choosing Report Set or Single Report level Export, press the Export button.  
You will get a Save File dialog that prompts you for where you want to save the 
file.  This should be dropped in a location where the folks who want to import it 
can get to it.  The file does not have to retain the existing name, but should be 
named something meaningful in a MSP-REX context. 
 
Additional Export options are expected in future versions of MSP-REX. 
 

 

Importing, Renaming, and Deleting Report Sets 

MSP-REX accesses Report Set definitions stored in a userôs personal profile area.  If 
another users definitions or a common set of definitions has been exported to a common 
folder, you will need to use Import functionality to copy those definitions into your profile 
area. 
 
Functionality for Importing single Reports and full Report Sets, as well as renaming 
Report Sets can be handled from the same page in the Backstage area. 
 

 
Reports Section ï Backstage Area 

 
1. Navigate to the Reports page via the File tab 

 
2. and the Report button. 
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Importing Reports and Report Sets 
 
Once youôve arrived at the Reports section of Backstage, the Import process is begun by 
pressing the ñSelect Import Directoryò button (item 3).   A ñBrowser for Folderò dialog will 
pop up, where you can navigate to the location where the Exported Report Set or Single 
Report file(s) reside.  Note that if these files were placed in an area that does not have a 
drive mapping, you can enter the UNC name (for example 
\\ServerName\SharedFolderName) into the Folder text box of the dialog.  After you press 
the Ok button on the dialog, MSP-REX will scan the indicated folder looking for files that 
match the export format for Reports and Report Sets, and populate the appropriate drop 
down lists (items 4 and 6).  After these lists have been populated, you can use the drop 
down box for the Report or Report Set to select the definition youôd like to Import, 
followed by clicking on the appropriate Import button (item 5 or 7). 
 

 Because Report Sets are stand alone, import is pretty straightforward, as we just 
deal with the files as a whole.  MSP-REX simply copies the file into your profile 
area, and sets the imported Report Set as your new current Report Set.  If the 
Report Set being imported has the same name (based on file name) as one of 
your existing report sets, youôll be prompted to Rename, Replace, or Abort the 
import.  Rename will allow you to save the imported Report Set with a new name.  
Replace will overwrite your existing Report Set. 

 

 Importing single reports is actually much more involved.   We need to merge the 
definitions into the current report set and resolve any duplicate report, filter, or 
table names.  Each component name (Reports, Filters, or Table), if duplicated, is 
subject to the same Rename, Replace, or Abort considerations as the full Report 
Set. 

 
 

Renaming or Deleting Report Sets 

 
Once you start collecting Report Sets, you may need to rename some of them to better 
reflect the context of the included definitions (PWA, report types, etc), or to help avoid 
duplicate name collisions on import.  Some may also become redundant or obsolete and 
should be deleted. 
 
As previously noted, MSP-REX stores Report Sets in the userôs personal profile area of 
his PC.  At the time MSP-REX is started up, it will check that area and populate the list 
of available Reports sets, both in the Context bar of the ribbon in the Select tab, and in 
the Reports sections of the File (Backstage) tab.  Using the drop down list in the 
Backstage area (item 8), you can select and rename or delete Report Sets as needed. 

 

 Rename Report Set: (Item 9) When you select this menu option, youôll get the 
following dialog:   
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Enter your desired name into the ñNew Nameò field and press Ok.   The new 
name will also be applied to the Report Set list on the Select tab. 
 

 Delete Report Set: (Item 10) Deletes the selected report in the Report Set list 
(Item 8).   You cannot delete the currently active Report Set. 

 
 
 
 

Report Set Strategies 

 If multiple MSP-REX users have a need to run the same reports or if generic report 
formats and/or filtering schemes exist, consider Exporting these definitions to a 
central location where any user can import the report set(s). 
 

 Remember that after a Report Set is Imported, it becomes a local copy and any 
changes only affect the local copy.   This is both good and bad.  Good in the respect 
that generic reports can be turned into specialized reports with a minimum of effort.   
Bad in the respect that standard reports can easily become non standard, and 
specific to a user.   

 

 If a centralized store of common Report Sets is maintained, a method of announcing 
changes to the central store is needed so users can re-import the updated Report 
Sets. 

 

 Individual Report and Report Set files Export to a text file format called ñxmlò, which 
can easily be emailed as an attachment.  This provides an alternative to exporting to 
a central file share.  Once the Email attachment is saved to a local location it can be 
Imported by another MSP-REX user.  This holds true for both Single Report Exports 
and All Report (Report Set) exports. 
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Options 
 
MSP-REX provides a limited number of configuration options.  They are accessible via 
the File (Backstage) tab, and the Options button. 
 

 
Backstage Options Page 

 
The following options are included: 
 

1. Common Configuration Folder:  This is the folder that you point to the first time 
you start up MSP-REX.   It is the central location where configuration information, 
maintained by the MSP-REX Administrator, and shared by all MSP-REX users is 
stored.  Normally this folder should not change.  However, should the 
Administrator need to move the folder due to reorganization issues, this option 
allows the general MSP-REX user to point his copy at the new location.  The new 
folder location needs to have had the configuration files moved prior to 
reassignment. 
 

2. Preferred Generation Folder:  This option simply sets a default folder for the 
Save File dialog used when setting the Generation target file. 
 

3. Preferred Export Folder:  This option simply sets a default folder for the Save File 
dialog used when Exporting Reports and Report Sets. 

 
4. File Size Threshold:  In enterprises where a large number of projects and tasks 

may be selected for a MSP-REX Project file generation, the generated file size 
can get too big for Project Pro to swallow and convert from XML to .mpp in one 
pass.  To alleviate that problem, we set a governor on how big a file we can 
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handle at one time.   Subsequently weôll generate our files in chunks of 
approximately the threshold size, convert each chunk from xml to mpp format 
individually, and then merge the .mppôs together as a last step.  This option 
allows you to change the default threshold.  Setting a smaller threshold means 
more chunks, which should load and convert to mpp faster, but more time is 
needed to merge them back together into one final result.  Setting a larger 
threshold swings the opposite way, and you run the risk of exceeding what 
Project Pro and your PC can handle.  15-20 MB seems to be a reasonable 
tradeoff, being big enough so most reports will not need to be chunked out, yet 
small enough that Project Pro can handle it without hanging up. 
 

5. Language for Labels:  At the time of this writing, MSP-REX only supports 
English.  However Spanish is an anticipated extension, with additional languages 
added as needed. 
 

6. Themes:  MSP-REX can have its look and feel, primarily in the ribbon area, 
modified to reflect various Microsoft Office themes.  Selecting one of the option 
buttons will change to the new theme.  The selected theme is remembered and 
applied on subsequent MSP-REX start ups. 
 

7. Theme Tint:  In addition to the slight changes in format and color that the themes 
apply, an additional tint can be added to the color.  The Theme Tint button (click 
the drop down arrow within the button) allows you to pick a new custom shade to 
fit your preference.  The button will bring up the following dialog: 
 
 
 

 
You can hover your mouse pointer over the various 
theme colors shown, and the results will be 
dynamically shown on the Options page.  Note that 
the colors in the box may not translate directly to the 
page; as it is a tint the effect will be lighter, and the 
tint is added to the existing theme color.  Once you 
find a color you like, click on it to set the tint. 

 
 
 
 
If, after trying a few tints, youôd like to revert to no additional tinting, simply select 
a new theme from the theme options (or switch to a new theme then back to your 
current theme if youôre already on the base theme you prefer).  This will clear the 
tint and revert to the coloring associated with the selected theme. 
 
 
 
There are also additional color selection options available by clicking on the 
ñMore Colorséò button. 
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In this case moving the mouse 
around only shows the selected 
color in the comb, it does not 
dynamically apply the color to the 
theme.  Youôll need to click on a 
color, then click on OK for the color 
to be applied to the theme.  If the 
results are not as desired, try 
again. 
 
 
 
 
 
One final color option is to click on 
the ñCustomò button on this dialog. 
 

 
 
 
For this option there are two 
primary means for manipulating 
color.  The pointer noted in Item 1 
is used to control the lightness or 
darkness of the hue.  When this 
color control is first shown, the 
pointer is all the way up, so the 
selected color will always look 
white.  We recommend dragging it 
about halfway down with your 
mouse, then mousing around in the 
color area (Item 2) to find the hue 
you like.  Last, move the 
lightness/darkness pointer again 
until you find the saturation you 
like. 
 
Like the comb, you will only see the 
effect on your theme when you hit 
the OK button. 
 

 
At the time of writing, themes and colors are newly introduced to MSP-REX, and some 
portions of the interface still do not pick up on the theme colors.  
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Walkthrough  
 
Now that weôve laid out all the details of the MSP-REX functionality, letôs do a 
walkthrough for creating a report from scratch.  Weôll assume the administrative setup is 
already complete. 

 

Table Creation 

Create a table.  Any generated file will need an output format, where we identify which 
columns, in what order, column widths, justification, etc.  To do this we need a table 
definition.  In many cases you will likely have a definition that is similar to your desired 
layout; the thing to do then is copy the original and tweak to suit.  This time weôll start 
with a default. 
 

    
 
 
Select the Edit tab, then the Tables button to get to the   
Table work area, then the Copy button. 
 
 
 

 

 
 
Select ñDefault Columnsò, enter a table name, and hit Save.  If you were to create a new 
table based on a different table youôve already customized, youôd select the ñCopy 
Tableò option, then open the appropriate table group and select a source table to copy. 
Note that since ñDefault Columnsò is selected, the ñCopy From Tableò tree is disabled 
(grey background) and will not respond to input. 
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The table work area should now show the copied table. 
 

 
 
 
The selected columns list should show the default columns.  Add any additional columns 
from the Unselected Columns by selecting one or more column names and clicking the 
left arrow.  Remove any unwanted columns from the Selected Columns list by selecting 
one or more column names and clicking the right arrow.  Set the order youôd like the 
columns to appear, left to right, in the resulting Excel or Project report by performing the 
following steps: 

 Select the column or columns youôd like to move in the Selected Columns list 

  Use the single up arrow to move it/them one column to the left (up in the 
columns list).   Repeat as needed. 

 Use the double up arrow to move it/them all the way to the left (top in the 
columns list). 

 Use the single down arrow to move it/them one column to the right (down in the 
columns list).  Repeat as needed. 

 Use the double down arrow to move it/them all the way to the right (bottom in the 
columns list). 
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 You can adjust the preferred output Width, Alias, or Alignment of a column by 
selecting the column and changing the values at the bottom of the form. 

 Select a new column or columns and repeat the process until complete. 

 Select an existing, or type in a new Group name, and optionally a description for 
your table. 

 Note that for changes to Group, Description, Width, Alias, Alignment, and 
Summary Fill Down, youôll need to tab out of the field or select a different field 
with your mouse for MSP-REX to know youôve finished your change so it can 
apply it to the table definition. 

 
Notes on Shadow Fields:   
 
If your intended output is a Project file, and you want to include project level fields (fields 
that contain the same values for an entire project), youôll need to use ñshadowò fields.  
Shadow fields allow project level data to be shown at the task level for the multiple 
projects that can be selected and generated by MSP-REX.   They have the same name 
as the project level fields, only with a ñProject: ò  prefix.  They are also designated in the 
column lists as being dark green, whereas the standard project fields are designated as 
light green.  Shadow fields are only used by MSP-REX for Project file reporting; they do 
not physically contain data in Project Server.  If you need a shadow field for a Project file 
extract and cannot find one, please contact your MSP-REX administrator, who can 
create the field and move it to the master pick list.  If you do include project level fields 
(light green) in a table definition, they will be ignored in the Project file generation.  If 
your intended output is an Excel file, you can specify project level fields (light green) 
directly; shadow fields are not required.   You can reuse tables defined for Project file 
generation; the Excel generation process will handle the remapping.   
 
Note that youôll receive a nag message about this at Save time if Project fields (light 
green) are included. 
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Note that after changes have been made to the table, a ñTable Modifiedò message 
shows in red in the Change Status area.  Once you have the table laid out the way you 
wish, press the Save button.  This will save the table changes for future sessions, and 
reset the status to ñTable Unchangedò.    
 
 

Filter Creation 

Every report extraction needs a table definition and at least one filter definition.  Itôs 
possible the filter definition may not actually have filter criteria; in fact the ñout of the boxò 
Default Filter has no criteria and as a result will select all existing projects. 
 
We will create a custom filter that includes Project level, Task Level, and Resource level 
criteria, as well as criteria to limit tasks being generated into the target file. 
 

 
 
Select the Edit tab, then the Filters button to get to the 
Filter work area, then the Copy button. 
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In this case, weôll start with ñAll Projectsò (a filter with no selection criteria) and build it up 
from scratch.  You could also start with an existing filter by selecting ñCopy Filterò, 
opening the appropriate filter group, and selecting a filter to Copy. Note that since ñAll 
Projectsò is selected, the ñCopy From Filterò tree is disabled (grey background) and will 
not respond to input.  Enter a new Filter name and press Save. 
 
The Filter work area should now show the copied filter. 
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MSP-REX allows you to create filters with a full range of filtering capabilities, but as 
filtering is often based on specific value or values we start by setting a value for the field 
of interest then tweak it as needed. 
 
Our first criteria will be any projects that have ñSoftwareò in their project name.   By 
default, the ñField Sourceò box in the upper left is pointing to ñProjectò when the Filter 
Edit dialog is opened.  This means that the Filter Fields list contains a list of all the 
project level fields that are available for filtering.  This can include both ñbuilt inò and 
Enterprise Custom fields.  The list is controlled by the MSP-REX administrator; if you 
canôt find a field you believe should be available please contact your administrator.  
There are some limitations here; weôre limited to what data is in the Reporting database, 
so some data, such as Predecessors/Successors is not available. 
 
Select the ñProjectNameò field from the list.  This will cause a list of all existing project 
names to be shown in the Values list.  We will further reduce this list by typing ñSoftò in 
the Find box: 
 

 
 
Although weôre ultimately only going to use one filter condition for project names, letôs 
start by selecting a couple of values via CTRL click, and moving them to the conditions 
list by clicking the down arrow. 
 

 
 
MSP-REX automatically set up a list of conditions with an equals test and an ñOrò 
connector.  But as you can see from the full list of values we could have by filtering on 
ñSoftò (based on the Find: value), if we wanted to include all ñSoftò projects weôd end up 
with a sizable list of conditions, connected by ñOròs.    It would be simpler to just have 
one condition, where the test would be ñContains Softò. 
 



Page 57 of 71    9/15/2011 

To do this weôll start by removing the extra condition lines, then clicking the trash can 
icon in the lower right.  This should leave a single condition line.  Weôll now double click 
on that line.  This should bring up a Refine Condition dialog: 
 

 
 
This dialog will have the field name, ñProjectNameò in this case, as a preset value, with 
an = (equals) test and the actual value selected. Weôll change the = (equals) test to 
ñContainsò and type ñSoftwareò into the dialog box. Your Refine Condition dialog should 
match the screen shot below. 
 

 
 
In this case itôs the first condition line in a condition group, so the And/Or dropdown box 
remains empty.   If we were dealing with additional conditions on a compound condition, 
we could change Andôs to Orôs or vice versa with that dropdown. 
 
Click Ok to set the refined condition back into the condition list. 

 
 
As youôre working on filters, you can do interim queries to test what results they return by 
using the ñRun Queryò button.  Note that your filter changes are still not permanent, and 
that a ñFilter Modifiedò message shows in the Change Status area.   It can be useful to 
defer saving changes while youôre working up a filter, as you can start over by using the 
ñResetò button.  Reset restores all Table, Filter and Report changes to the state they 
were in when the last save occurred.  You should click Save once youôre happy with the 
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filter execution results.  Note that since weôre only working at the filter level, the field list 
used on the test queries will be that of whichever table was used last. 
 
Now letôs move onto adding a Task criteria.  Weôll look for projects that have tasks that a 
Start Date between 8/1/2010 and 9/1/2010. 
  
In the Fields Source box, select Task.  This will load the Task level fields that are 
available for filtering.  Choose TaskStartDate.  When you choose a date or numeric field, 
MSP-REX will change the Value pick list to range selection fields.  For dates, if you click 
on the dropdown arrow a calendar control, like the one in ñRefine Conditionsò will pop 
up. 
 

 
 
You can navigate the calendar control to pick the dates, or enter the date values directly.  
Enter both dates for the range.  Click on the down arrow to move the range to the 
Condition list.  (The second date must be >= the first date).  If you donôt want a range, 
and would just like to search for greater than or less than a certain date, use the Refine 
Condition dialog once the item is in the Condition List. 
 

 
 
Note that MSP-REX has added a pink ñAndò line between the ProjectName and 
TaskStartDate conditions.   This signifies that TaskStartDate is in its own Condition 
Group.  (See ñThe Condition List and Condition Groupsò section earlier in this manual for 
more details.)   At the moment, we can either just leave the Condition Group ñAndò, or 
delete that line via the trash can and add an ñAndò to the TaskStartDate ñAnd/Orò field 
via the Refine Condition dialog; the effect will be the same.   
 
But letôs temporarily add another condition to show how and why condition groups are 
useful, so the test is ñTask Start Date is in Aug 2010ò or ñTask Finish Date is less than 
Sept 2010ò. 
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To do this: 

 Add ñTaskFinishDateò as a condition line. You could add the date in a range 
(doesnôt matter what it is as weôll tweak it anyway), or more simply, use the Right 
Click shortcut on the TaskFinishDate field, which will set up the new condition 
lines and bring you directly to the Refine Condition dialog. 

 Using Refine Conditions set the condition to ñ< 9/30/2010ò and set the ñOrò 
value. 

 Remove the new pink Condition Group ñAndò line so the Task Start and Task 
Finish Dates are tied together 

 
The pink ñAndò line does two things for us.  One, it allows us to mix ñAndò and ñOrò 
conditions, i.e. in order for a project to be selected it must both have a name with ñSoftò 
in it and either of the two options for date selection.  It also visually makes the distinction 
more obvious. 
Weôll change our conditions once again, selecting projects with tasks having scheduled 
activity within Q3 2010 (for this example weôll assume thatôs between 7/1/2010 and 
10/1/2010), and continue building our filter by adding a resource check for an Analyst. 
 

 
 
Again, hereôs an example of where the separate condition groups will make a difference.  
This is an example of what is more fully described in the ñSpecial Task/Assignment 
Conditionsò section. As currently set up, to be selected a project will need a name 
containing ñSoftò, a task scheduled during Q3 2010, and an Analyst resource in any of 
its tasks.  If we were to remove the second pink ñAndò line, to be selected a project will 
need a name containing ñSoftò, a Q3 task, and an Analyst resource assigned to a task in 
Q3, as the Task criteria and the Resource criteria would be grouped together. 
 
So far all the criteria weôve specified apply to selecting projects.  Without any further 
qualification the generated Project or Excel reports would show all the tasks and 
subtasks for the selected projects.  MSP-REX offers an additional level of filtering that 
gets rendered at the task level via the Task Rendering options. 
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By default All Tasks get rendered.  However, if task or resource level criteria are 
specified, we have the option of limiting the tasks that are outputted to those that satisfy 
the task/resource criteria, with three variations. 
 

 Task Hierarchy:  If a task satisfies the task/resource selection criteria, only that 
task and any task parents going up to outline level 1 will be rendered. 
 

 Filter Group From Top:  If a task satisfies the task/resource selection criteria, it 
and all sibling subtasks going up to outline level 1 will be rendered. 

 
 Filter Group From Bottom:  This is essentially a combination of the first two 

variations; if a task satisfies the task/resource selection criteria, that task and any 
task parents going up to outline level 1 will be rendered, as well as all subtasks of 
the task that satisfies the selection criteria. 

 
For our example, weôll use Task Hierarchy. 
 
Weôll also set the Filter Group and Description for our filter, and Save the Filter definition. 
 
 

Ad Hoc Reporting 

Now we have a table definition and a filter definition, which is all we need to run a report.  
In the MSP-REX world there are two ways to create reports: 
 

 Ad hoc by selecting/combining any existing tables and filters, adding file type 
(Project or Excel) and destination, executing the filter (or filters), moving the 
desired projects to the generate list, and running the generation process. 
 

 Canned Reporting, where all the ad hoc pieces are stored in a report definition.  
Execution results in projects moved to the generate list.  At this point the user 
can review and/or change the generate list and run the generation process. 

 
To do ad hoc reporting, we work off the Select form.  First weôll pick a table by clicking 
on the Tables tab, opening the ñMy Custom Tablesò group we created earlier, and 
selecting the Walkthrough Table we created. 
 

 
 



Page 61 of 71    9/15/2011 

This will set the current table, and show the table fields in the Filters/Table details list: 

 
 
 
Likewise, for filters weôll select the Filters tab, open the Walkthrough filter group we 
created, and select the Walkthrough Filter.  This will set the current filter, and show the 
filter criteria in the Filters/Table list: 

 
 
Next we need to set the type of file we wish to generate, and set the filename and target 
directory.  Set the type in the Output Type option box, and set the target location by 
using the ñéò (ellipsis) button.  The button will open a ñFile Saveò dialog where you can 
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navigate to your desired directory and set the file name.  You need not specify the file 
extension (.mpp or .xls), MSP-REX will set that depending on your selected type.  Weôll 
select Excel as our sample output. 
 

 
 
Now we need to execute our filter, and pick which resulting projects we want to include 
in the generated set.  To execute the filter, press the ñApplyò button in the lower left 
corner.  The filter execution results will be shown in the Results List (the upper list). 
 

 
 
The results list shows columns from the current table, but as the results are only at the 
Project level only Project level fields from the table will be shown.  A label will also show 
how many projects were found.  That number often provides a sanity check on whether 
the filter is working as intended, or needs further editing.   
 
A side note: You could conceivably use MSP-REX strictly as a tool to find projects that 
satisfy certain criteria.  Depending on what Project level fields you call out in your table 
definition, you might find the information you need directly without the need to generate 
any files.  You could also use these results to find and edit projects ï double clicking on 
a project line will open it in Project Pro.  In either of these scenarios, the table definition 
would only need Project level fields.  The results list can also be sorted by clicking on a 
results column header. 
 
We still need to select the projects to be generated.   
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If all the projects in the results list should be generated, select the ñAllò option in the ñTop 
List Itemsò box and click on the + (plus) button.  If you only want a subset of the top list, 
select the desired projects and the ñSelectedò option.  The plus button will merge all or 
selected projects from the top results list into any projects in the bottom (projects to 
generate) list.  Duplicate projects will be eliminated.  For more details on the + (plus), - 
(minus), = (equals), and trash can buttons see the Main Form Overview section.  The 
short version is, they can be used to combine results from multiple filters. 
 
Now that you have everything set up, all you need to do is press the ñGenerate Fileò 
button. 

 For Excel files, MSP-REX will query the database to get the Project, Task, 
Assignment, and Resource information designated in the table and filter, open a 
copy of Excel, and update the cells with the results.  Each time a new project is 
encountered Excel will highlight it in blue.  Task names are indented based on 
Outline Level.   A progress dialog will also display, showing how far along the file 
generation has proceeded. 

 
 

 For Project files MSP-REX takes a different approach; it generates XML files that 
Project can import.  As it is possible to use MSP-REX in an environment with a 
large number of Projects/Tasks being generated into a single project file, this 
process may be segmented into multiple XML files, with each converted back 
into a Project file, and then merged together as a final step.  During XML 
generation, a progress dialog will also display, showing how far along the XML 
generation has proceeded.  A status dialog indicates how the XML to mpp 
conversion is going.  You should wait until the dialog indicates ñMaster File 
Generation Completeò before working on the generated Project file.  
 



Page 64 of 71    9/15/2011 

 
 
 
 
Once you see the generated results, you may opt to return to the table definition and fine 
tune column widths, Aliases, Alignment, etc.  Column widths work out about the same in 
both Project and Excel, and the Width scale bar in Table Edit.  Width can be seen in a 
tooltip in Excel, and on the status bar at the bottom of Project when resizing columns 
 
Itôs entirely possible to generate a report in Excel, then simply change the type to Project 
and generate it again.  The caveat here is the use of Project level data fields; for Project 
generation youôll need to use shadow fields with the ñProject: ñ prefix, for Excel you can 
use either shadow fields or direct Project level fields.  One other gotcha; as Excel 
doesnôt have a separate area to show Assignment level information, if a task has 
multiple resource assignments the task line is repeated, only the Assignment information 
changes. 
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Formal Reporting 

Weôve already built up the needed components, and manually executed the steps to 
select a table, filters, file types, and names.  But if youôve come up with a report youôd 
like to run on a regular basis it would be nice to have it all configured, so all you need to 
do is execute the report and generate the file.  Thatôs where Report definitions come in. 

 
  
 
Select the Edit tab, then the Reports button to get to the 
Report work area, then the Copy button. 
 
 

 
This will bring up the New Report dialog: 

 
 
In this case, weôll start with ñRpt ï No Contentò.  You could also start with an existing 
report by selecting ñCopy Reportò, opening the appropriate report group, and selecting a 
report to Copy.  Enter a new Report name and press Save. 
 
You should now see the copied report in the Report work area.  Youôre also likely to get 
this error, as the ñNo Contentò report we copied from is, by definition, broken.  
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Note how the new report name is highlighted in red.  This also indicates the report is 
ñbrokenò, i.e. itôs missing its table assignment, a filter assignment, or both.  Weôll assign 
the table and filter we built earlier in the walkthrough. 
 
Go to the filter tab, open the Walkthrough group we created earlier, select the 
Walkthrough filter, set the Action to Merge, and click the right arrow to copy to the 
Filter/Table list.   
 

 
 
Notice that as we add criteria to the report, the Filter/Table details list begins to show the 
results: 
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The Table assignment works the same way.  Go to the Table tab, open the ñMy Custom 
Tablesò group we created earlier, select the Walkthrough Table, and click the right arrow 
to copy to the Filter/Table list.  In this case we do not have to set an action, itôs always 
ñApply Tableò for tables. 
 

 
 
 
Again, the Filter/Table details are updated.  Note as well, that the ñReport Modifiedò 
status is shown: 
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You can assign multiple filters to be executed.  They will be executed, with the 
designated Action, in the order displayed.  While you can temporarily assign multiple 
tables, MSP-REX will assume youôre just replacing a table by adding a new table and 
deleting an old one.  Use the up and down arrows to make the table the last item, and 
set filters in the order of execution.  Filter Actions correspond to the Action buttons on 
the main form; Merge to + (plus), Subtract to ï (minus), and Only Matches to = (equals). 
 
Now assign the desired file type to generate, a group, description, and file location and 
name.  Thereôs no need to assign a file extension (.xls or .mpp) to the file name. 
 

 
 



Page 69 of 71    9/15/2011 

You can test the report definition by pressing the ñRun Queryò button.  Note that the 
report definition still is not Saved, it only exists in computer memory.  Executing the 
report transfers control to the Select page, sets the table, file type, file name, and 
executes the filters/actions in order.  Return to Edit Report and Save the report when 
complete. 
 
Once a report has been defined, you can access it from the Reports tab on the Select 
form and hit Run Query to run it.  Youôll still need to review the projects that have been 
set in the project generation list.  Press the Generate button when everything looks good 
to go. 
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Limitations an d Restrictions 
 
MSP-REX is a powerful tool, but it does have certain limitations: 
 

 When creating Project output files, the results should be considered a snapshot 
of the extracted Projects and Tasks, and not something suitable for Project 
planning beyond a visual analysis.  This is true for the following reasons: 
 

o MSP-REX gets nearly all of its information from the Project Server 
Reporting database.   Since this database is intended for reporting rather 
than supporting the scheduling effort, it does not contain all the elements 
needed to completely reproduce a Project.  For example, a key missing 
ingredient is Task Type (Fixed Work, Fixed Duration, Fixed Units).   MSP-
REX always uses Fixed Duration, regardless of what the original Task 
type was. 

o Project is a scheduling engine, and normally works up its results based 
on dependencies between tasks (Predecessors and Successors) and 
constraint types (As Soon As Possible, Start No Earlier Than, etc).  Since 
MSP-REX may not render all the tasks in a Project depending on filtering, 
dependency results can change.  Even more significantly, a project will 
often generate its schedules relative to the Project Start or Finish date, 
and in the MSP-REX context, that will always be the earliest start and 
latest finish of all the projects that contribute to the final result. 

o Task level filtering may be included, which could omit tasks that might 
otherwise contribute to scheduling dependencies. 

o Calendar info is very basic, no custom calendars are rendered. 
o As a result, when MSP-REX creates a project file, in order to most closely 

represent the schedule dates and durations that each individual project 
and task actually have in Project Server, it always uses the following 
settings: 
Á A Start No Earlier Than constraint on summary tasks 
Á A Must Start On constraint for subtasks 
Á The constraint dates set to the dates the scheduling engine has 

worked out in the real schedules 
Á Fixed duration on the tasks, with the duration matching the value 

in Project Server for each task.  The Finish date should then be 
consistent with the original Project Server task. 

 

 MSP-REX ignores Master Projects.  It will process Sub Projects. 
 

 If Projects contain cross project dependencies, the external task will show as a 
project task, but not as an external task.  The Excel output will color code that a 
task is an external task, but cannot identify the parent project.  The Project output 
can show Gantt dependencies for what would otherwise be considered an 
external task but does not reflect the original external link path; it shows the 
target ID in the generated file. 
 

 Predecessors and Successors are generated into the Project output if the 
Publishing database connection string is defined by the MSP-REX administrator.  
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However those fields will not show up in the Table pick lists, they have to be 
manually shown in Project.  Excel output does not support Predecessors and 
Successors at all. 
 

 In Excel based output, if the Table definition includes Assignment level data and 
a Task includes multiple Assignments, each Assignment is rendered as a 
separate row in the Excel output.  This means if you also have Task level fields 
that you add summation to, you can get double entry of the task values as it is 
repeated for each Assignment line. 
 

 If a filter uses Task Rendering options other than ñAll Tasksò, and the Projects 
selected have a large number of Projects/Tasks (5000 plus), you may encounter 
time out errors due to the size and complexity of the queries needed to resolve 
the hierarchies. 

 
 MSP-REX should be compatible with Project Server 2007 or Project Server 

2010, but does not support Project Server 2003. 
 

Chances are youôll think of other functionality youôd like to see added to MSP-REX.  

Please contact Advisicon at Development@Advisicon.com with any new ideas or 

bug reports. 

mailto:Development@Advisicon.com
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